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Description 

Many parts fail from fatigue—the repeated cycling of the load, which causes failure even though 
the calculated stresses are well below a normal allowable stress value such as the yield 
strength. Instead of designing to an arbitrary factor of safety, you can use your simulation 
analysis to perform a fatigue analysis. Based on the cyclic loading scenario that you provide, 
Autodesk Nastran In-CAD software will determine the number of cycles to failure or the 
damage. This session will discuss the options available for the fatigue analysis, the meaning of 
the input, and the interpretation of the results. This session features Nastran In-CAD. 
 

Your AU Expert 

John Holtz is a Technical Support Senior Specialist at Autodesk where he focuses on solving 
customer’s questions related to the simulation products. Prior to his role in Technical Support, 
he was a user experience designer and author of the User’s Guide, both roles for Simulation 
Mechanical. 
 
In addition to Autodesk, he has worked for engineering firms that design steel mill equipment: 
reheat furnaces, arc furnaces, and rolling mills. Simulation work has covered a range of analysis 
types, from simple beam models for transfer cars and product conveying equipment, to 
combined plate and brick models for thermal stress analysis of electric arc furnace (EAF) shells, 
to CFD analyses of induced draft exhaust stacks. He has experience with Algor, ANSYS, 
Autodesk Simulation Mechanical and Autodesk CFD. 
 
John began using commercial simulation products, or finite element analysis (FEA) as it was 
known back then, in 1989 on a 386 computer with VGA graphics. He has a Bachelor of Science 
degree in mechanical engineering from the University of Pittsburgh and is a professional 
engineer (P.E.) in the state of Pennsylvania. 
 

Learning Objectives 

 Recognize what type of model is suitable for fatigue analysis 

 Learn how to enter the material and manufacturing properties and loading history 

 Understand the fatigue results 

 Learn how to generate a report that contains the fatigue analysis 
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Introduction to Fatigue 

 

As engineers and designers, our first goal is to design a product that will meet the requirements 
necessary for a functional and safe design. For example:  

 A product subjected to mechanical loads will not exceed an allowable stress or 
deflection 

 A product subjected to thermal loads will meet certain temperature or heat loss 
requirements 

 A product subjected to moving fluids will meet certain criteria related to pressure loss, 
drag loss, volumetric flow 

The criteria for a safe design are often a fixed factor of safety related to the strength of the 
material. For example, the allowable stress may be one half of the yield strength. The factor of 
safety may be provided by a published code or standard, or it may be based on experience. 
Different factors of safety may be used depending on whether the load is static or dynamic, the 
environment in which the product is used, and other factors. 
 
Although many products are satisfactory under the design loads compared to the material 
property such as the yield strength (with an appropriate factor of safety), they often fail because 
the product experiences thousands or millions of load cycles throughout their life. Such loads 
can cause a product to fail at a load magnitude that is much smaller than the load required to 
reach a material strength. Such failure is known as fatigue. 
 

 

FIGURE 1- A SMALL FAN FOR PERSONAL COMFORT. ONE SIDE OF THE BRACKET HAS 

FAILED; THE OTHER SIDE HAS CRACKED AND WOULD HAVE FAILED SOON.  
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Engineering Background 

Fatigue failure is the process in which a microscopic crack will grow when stresses vary due 
time-varying loads, and when there is some tension in each cycle. As the crack grows with each 
cycle, the cross-sectional area supporting the load reduces to the point where the part fails 
catastrophically. 
 
Unlike a static failure, in which the part usually develops a large displacement because the 
stress exceeds the yield strength, a fatigue failure usually occurs without warning. It is sudden 
and total, and hence can be dangerous. 
 
Fatigue is a complicated phenomenon and is only partially understood. No analytical design 
approach provides precise results, in part because the phenomena is due to “random” factors in 
the material. Fatigue is one branch of engineering that requires material testing to guard against 
failure. 
 
None-the-less, the designer and engineer can benefit from a “starting point” to design the 
product before any testing is begun. There are two basic analytical methods: 
 

Stress-Life Method 
- Least accurate, especially for low cycle fatigue 
+ Represents high cycle fatigue adequately 
+ Easier to implement 
+ Has ample supporting data 

Strain-Life Method 
+ Accurate for low cycle fatigue 
- More detailed analysis 
- Several idealizations are compounded, so some uncertainties will exist. 
- How to determine total strain at notch or discontinuity has not been answered. 
- No tables or charts of strain concentration factors. (Reference 1, page 270) 

 

Stress-Life S-N Diagram 

The stress-life method is characterized by the S-N curve, where S represents the alternating 
stress that causes failure, and N represents corresponding the number of cycles. A 
representative S-N curve is shown in Figure 2. 
 
A sample is loaded to a certain stress value, unloaded, and then loaded in the opposite 
direction. This is repeated until the part fails, which gives one point (N1, S1) on the S-N curve. 
The test is repeated with another specimen at a different level of stress until it fails, giving 
another point (N2, S2), and so on until the entire curve is created. 
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FIGURE 2 - S-N CURVE FOR FERROUS MATERIAL (STEEL) 

 
The points on the curve correspond to these values: 

A. Ultimate tensile strength, Sut. Failure occurs on 1 cycle 
B. End of “low cycle” region, generally at 1000 cycles. The stress is some fraction of the 

tensile strength, f × Sut. The value f is generally between 0.9 and 0.78. (See below.) 
C. End of “high cycle” region, generally at a point between 106 and 107 cycles. The 

corresponding stress is the endurance limit, Se, at a specified number of cycles Ne. 
 
Note that the segments are straight lines when plotted on a log-log scale. 
 

Fatigue Strength Fraction 

The fatigue strength at the end of the low cycle region (point B) is set to f × Sut where f=0.9 by 
some sources while others used a complex calculation (and some assumptions) to create a 
value that depends on the ultimate strength. The result of such a calculation is shown in Figure 
3. 
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FIGURE 3 - FATIGUE STRENGTH FRACTION, F (REFERENCE 1, FIGURE 6-18, PAGE 277.) 

 
Ferrous metals (steel) exhibit a clear limit or “knee” in the S-N curve (point C in Figure 2). At this 
level of stress (and lower), a fatigue failure will not occur regardless of how many cycles the part 
is subjected to. 
 
The S-N curve for nonferrous metals and alloys does not have a region where the curve 
becomes horizontal; hence these materials do not have a true endurance strength. But they 
often have a “knee” where the curve changes slope at point C.  

 

FIGURE 4 - S-N CURVE FOR NONFERROUS MATERIAL 
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Stress-Life Material Behavior 

The S-N curve can be created for a real part or a test specimen, but most published data is for a 
rotating beam test specimen. The endurance limit S’e found from such tests are applicable only 
to the test specimen. To use the data for actual parts, a number of factors need to be applied. 
The calculation of the factors is beyond the scope of this document. Please refer to a text book 
(such as reference 1) for details on applying the modifying factors. 

𝑆𝑒 = 𝑘𝑎𝑘𝑏𝑘𝑐𝑘𝑑𝑘𝑒𝑘𝑓𝑆𝑒
′  

where 

 Se is the endurance limit for a specific part 

 S’e is the endurance limit for a test specimen 

 ka is a surface factor that accounts for the finish (ground, machined, forged, and so on.) 

 kb is a size factor that accounts for the size of the part 

 kc is a loading factor that accounts for different types of loading (bending, axial, torsion) 

 kd is a temperature factor 

 ke is a reliability factor to account for scatter in the test results from one specimen to 
another. 

 kf is a miscellaneous factor to account for everything else (residual stress, directional 
characteristics, corrosion, electrolytic plating, and so on). 

 
No doubt by the time all of these factors are estimated, the accuracy of the results is 
questionable. Hence the need for actual testing! 
 
Note that point C in the above S-N curves would be either S’e if the curve is for a test specimen 
or Se if the curve is for the actual part (which includes all of the factors). For design work, you 
will always be using Se. 
 

Fluctuating Stresses 

The S-N curve generated for a rotating beam test specimen uses a fully reversing load; that is, 
the maximum and minimum stresses are the same magnitude. See (a) in Figure 5. If the load is 
not fully reversed, the S-N curve would have different values. Instead of creating different S-N 
curves for different loadings, different theories are used to adjust the alternating stress for use in 
the S-N curve to find the life. From Figure 5, define the following stress values: 

𝑆𝑚𝑖𝑛 = 𝑚𝑖𝑛𝑖𝑚𝑢𝑚 𝑠𝑡𝑟𝑒𝑠𝑠 

𝑆𝑚𝑎𝑥 = 𝑚𝑎𝑥𝑖𝑚𝑢𝑚 𝑠𝑡𝑟𝑒𝑠𝑠 

𝑆𝑎 = 𝑎𝑙𝑡𝑒𝑟𝑛𝑎𝑡𝑖𝑛𝑔 𝑠𝑡𝑟𝑒𝑠𝑠 𝑐𝑜𝑚𝑝𝑜𝑛𝑒𝑛𝑡 = |
𝑆𝑚𝑎𝑥 − 𝑆𝑚𝑖𝑛

2
| 

𝑆𝑚 = 𝑚𝑖𝑑𝑟𝑎𝑛𝑔𝑒 (𝑜𝑟 𝑚𝑒𝑎𝑛)𝑠𝑡𝑟𝑒𝑠𝑠 𝑐𝑜𝑚𝑝𝑜𝑛𝑒𝑛𝑡 =
𝑆𝑚𝑎𝑥 + 𝑆𝑚𝑖𝑛

2
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(a) Fully 
reversing 

 

(b) 

 

(c) 

FIGURE 5 - FLUCTUATING STRESSES 

 
When the midrange stress is nonzero and positive, the alternating stress component can be 
adjusted. The adjusted value is known as the zero-mean alternating stress, Sa0. Various fatigue 
criteria are available for the adjustment. These are generally shown on a graph such as Figure 
6. Any point “A” on the criteria is fatigue strength for a given midrange value. If the alternating 
stress is below the line, the part has infinite life. 
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FIGURE 6 - VARIOUS FATIGUE CRITERIA 

Se = endurance strength 
Sy = yield strength 
Sut = ultimate tensile strength 

 
The graph in Figure 6 tells us the following information: 

1. When the midrange stress is zero (a fully reversing load), the alternating stress can be 
as large as the endurance strength and still have an infinite life. 

2. As the midrange stress is increased, the alternating stress must be lower in order to still 
have an infinite life. 

3. When the midrange stress reaches the yield strength or ultimate tensile strength (for the 
Soderberg and modified Goodman criteria, respectively), the alternating stress goes 
down to zero in order to have an infinite life. Naturally, other design criteria may come 
into consideration at such high stress levels. 

 
The equations for the different criteria are given in the table below. They are used to derive the 
adjustment to the alternating stress to calculate the zero-mean alternating stress, Sa0. 
 

Fatigue Criteria 
Equation for 

Line 
Equation for Zero-mean Alternating Stress, 

Sa0 

Modified Goodman 
𝑆𝑎

𝑆𝑒
+

𝑆𝑚

𝑆𝑢𝑡
= 1 𝑆𝑎0 = 𝑆𝑎

1

1 −
𝑆𝑚

𝑆𝑢𝑡
⁄

 

Soderberg 
𝑆𝑎

𝑆𝑒
+

𝑆𝑚

𝑆𝑦
= 1 𝑆𝑎0 = 𝑆𝑎

1

1 −
𝑆𝑚

𝑆𝑦
⁄

 

Gerber 
𝑆𝑎

𝑆𝑒
+ (

𝑆𝑚

𝑆𝑢𝑡
)

2

= 1 
𝑆𝑎0 = 𝑆𝑎

1

1 − (
𝑆𝑚

𝑆𝑢𝑡
⁄ )

2 
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To re-iterate, the zero-mean alternating stress (Sa0) can be used on the S-N curve to determine 
the life of a part. 
 

Complex Cycles 

When the part is subjected to a single repetitive cycle, the calculation of the midrange and 
alternating stress are easily defined. In many situations, the part is subjected to multiple 
different load histories or “cycles” before the pattern repeats, such as in Figure 7. For the fatigue 
calculations, what are the number of cycles and the stresses? 

 

FIGURE 7 - MULTIPLE CYCLES 

 
One method of determining the number of cycles and stresses is the rain-flow counting 
technique. The procedure is a bit difficult to describe in words. I suggest watching videos on 
YouTube (such as references 2 and 3). Once the number of cycles and corresponding stresses 
are known, the fatigue can be calculated using the Palmgren-Miner cycle-ratio summation rule, 
or known simply as Miner’s rule.  
 
In the Palmgren-Miner rule, the one repetitive cycle is broken into smaller cycles ni (using a rain-
flow technique). The cycle ni has a midrange and alternating stress which allows the number of 
cycles to failure, Ni, to be calculated. If ni is smaller than Ni, the part will not fail due to the 
smaller cycle, but all of the smaller cycles together may cause failure. The number of repetitive 
cycles N of the load history that causes failure is then 

𝑁 ∑
𝑛𝑖

𝑁𝑖
= 1 

 

Strain-Life EN Diagram 

As indicated previously, the strain-life method is more accurate than the stress-life method for 
low cycle fatigue which is generally when the number of cycles to failure is fewer than 1000. In 
fact, the strain-life method is the best approach to explain the nature of fatigue failure. However, 
several idealizations are used in developing the theory which limits its usefulness. 
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The basic theory of the strain-life method can be summarized as follows: 

 Fatigue failures start at a local discontinuity such as a notch or material discontinuity. 

 Plasticity occurs locally when the stress exceeds the elastic limit; in other words, plastic 
strain occurs. 

 Fatigue involves multiple cycles, so the behavior of the plastic strain over multiple cycles 
is important. 

 The elastic limit can increase or decrease on each cycle due to an effect known as 
hysteresis or Bauschinger’s theory. See Figure 8. 

 

 

S = stress range 

 = total strain range 

e = elastic strain range 

p = plastic strain range 

 

FIGURE 8 - IDEALIZED HYSTERESIS LOOPS. A PART IS LOADED AND REVERSED BEYOND THE YIELD STRENGTH. 

 
A diagram similar to the S-N curve for stress-life can be created for the strain-life method. The 
diagram for strain-life is the E-N curve, where E represents the alternating strain (not to be 
confused with the modulus of elasticity), and N represents the number of cycles to failure. There 
are some important differences between the S-N and E-N curves: 

 There are two stress reversals per cycle N (Figure 8), so the horizontal axis of the E-N 
curve is based on 2N. 

 The strains normally refer to the entire strain range ( in the hysteresis figure), so the 

strain amplitude on the vertical axis of the E-N curve is based on /2. 

 The failure curve is the total strain which can be expressed as the sum of the elastic and 
plastic strain. 
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FIGURE 9 - E-N CURVE 

 
Note that the elastic and plastic strain lines are straight lines when plotted on a log-log scale. 
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Fatigue Analysis with Nastran In-CAD 

 

The setup of a fatigue analysis with Nastran In-CAD is similar to a linear stress analysis but with 
three slight differences. Inevitably, I forget to set one of these steps, so here is the list so that 
you do not miss one of the steps (Figure 10): 

1. Set the analysis type to fatigue: “Analysis > Type > Multi-Axial Fatigue” or “Vibration 
Fatigue”. 

2. Include the material properties for fatigue: “Material > Fatigue”. 
3. Define how the loads change during one repetitive cycle: “Loads > Load History 

Table Data > New Table”, or define the PSD for a vibration fatigue analysis. 
 
In addition to the above items, there is a dialog with additional setup and input for the fatigue 
calculations. The main changes you will make are the type of life calculation you want to 
perform and the type of stress to use for the calculations: 

4. “Fatigue Setup > Approach > Stress-Life” or “Strain-Life”, and “Fatigue Setup > 
Method > von Mises” or “Maximum principal” or “Maximum shear”. 

 
Each of these steps will be detailed on the following pages. 
 

 

FIGURE 10 - FOUR STEPS TO FATIGUE ANALYSIS 

 
The fatigue calculations are performed on the following element types. Other element types can 
be included in the stress analysis (such as rigid elements), but the fatigue life will be ignored for 
the other element types. Because the fatigue calculation uses the method of superposition 
(which states the results due to multiple loads are the sum of the results due to each load), 
separation contact cannot be included in the analysis. The supported element types are: 

 Solid 

 Shell 

 Line (bar and beam) 
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1. Analysis Types 

Edit the analysis type to choose the type of stress analysis to perform for the fatigue 
calculations: 
 

1.1 Multi-Axial Fatigue 

This analysis type performs a linear static stress analysis. As you would expect, the simulation 
is three dimensional; hence the terminology “multi-axial”. Otherwise, it is nothing more unique 
than a linear static stress analysis. 
  
Loads appropriate for a static stress analysis can be applied. Each load can be assigned to a 
load history which describes how the load changes over time. 
 

1.2 Vibration Fatigue 

This analysis type performs a random vibrations analysis (“Random Response”). The applied 
load is a power spectral density (PSD). 
 

2. Material Properties 

The fatigue analysis can be performed using a stress-life calculation or a strain-life calculation. 
This selection is made with the Fatigue Setup (step 4 in the above list). Each method uses 
different material input, but the fatigue material properties for each are entered by editing the 
material properties and clicking the “Fatigue” button. 
 
Each material can have its own fatigue properties. In fact, it may be necessary to create 
additional materials to accurately represent the fatigue properties for each part. In a normal 
stress analysis, the material properties are approximately the same for a given class of material. 
For example, it does not matter whether you choose a “high strength steel” or a “low carbon 
steel” from the standpoint of the stress results. The modulus of elasticity and Poisson’s Ratio for 
steel are generally the same for different chemistries within the same class of steel. (Naturally, 
from the standpoint of presenting a report to your customer, it makes sense to choose the 
“proper” steel.) 
 
But the fatigue material properties include effects such as size of the part, heat treatment, and 
type of loading. Therefore, it is often necessary to use different materials for different parts just 
to be able to represent the fatigue material properties. 

Warning about material properties 

If the “Mesh Model” branch of the browser looks like , the model 
needs to be remeshed. This is important to update the material properties. 
 

2.1 Stress-Life Material Properties 

The material properties for a stress-life calculation (Figure 11) define the S-N curve and are 
represented by two points: 

A. The point (N0, Su) represents the transition from low cycle to high cycle fatigue. 
B. The point (Ne, Se) represents the transition to infinite life. Ferrous material like steel have 

a well-defined endurance limit; that is, the S-N curve is horizontal after this point. 
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Nonferrous metals and alloys do not have a true endurance limit but typically transition 
to a “more infinite life” at some number of cycles and level of stress. 

 

 

FIGURE 11 - MATERIAL INPUT FOR STRESS-LIFE S-N CURVE 

 

 Su is the stress at the transition from low cycle to high cycle (point A in Figure 11). This 
value is typically the ultimate tensile strength of the material, the yield strength, or some 
fraction of those. 

o If the ultimate strength is used, then the life calculation follows the modified 
Goodman method. However, the slope of the high cycle S-N curve is only 
approximately correct. (See section Engineering Background, Stress-Life S-N 
Diagram, Fatigue Strength Fraction for the parameter f). 

o If the yield strength is used, then the life calculation follows the Soderberg 
method. 

o The slope of the S-N curve is usually not flat in the low cycle region. Point A is 
usually some fraction of the ultimate strength. If the fraction of the ultimate 
strength is entered for Su, the slope of the S-N curve will be more accurate, but 
the calculation for the Goodman method will be approximated. 

 N0 is the number of cycles at the transition from low cycle to high cycle (point A). This 
value is typically 1000 cycles. 

 Se is the endurance strength at the transition to infinite life (point B in Figure 11). This 
input is not the value for the polished test specimen. This input is the fully corrected 
endurance limit based on the material, size, and other factors. That is, Se=kakbkckdkekfS’e. 

 Ne is the number of cycles at the transition to infinite life (point B). This is not input but is 
used to calculate the slope B. (It is also good to know what the material properties really 
represent!) 
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 B is the slope of the S-N curve in the high cycle region; that is, from point A to point B. 
(Although the slope is negative, the software uses a positive input.) Since the S-N curve 
is a log-log plot, B is calculated as follows. Note that “log” is the base 10 logarithm; it is 
not the natural logarithm (“ln”). B is typically around 0.1 for steel. There may be 
something wrong if you have a much different value. 

𝐵 =
log(𝑆𝑢) − log(𝑆𝑒)

log(𝑁𝑒) − log(𝑁0)
 

 Be is the slope of the S-N curve after the endurance limit; that is, at number of cycles 
higher than Ne. 

 KF is a stress correction factor. If the mesh does not represent a particular stress 
concentration, this value could be used to correct the calculated stresses for the missing 
effect. However, note that this multiplier affect all nodes in the material. 

 

Warning about Kf. The input value of Kf is not used. A value of 1 is used for all 

calculations. 
 
Note that In-CAD does not use the S-N curve in the low cycle region. It assume that the curve of 
slope B extends all the way to N=0. 

Warning about the “Show XY Plot” 

The Fatigue material property dialog includes a function to “Show XY Plot”. The plot 
shows the wrong data for point B (Figure 11), so do not use the plot function. To see the 
S-N curve for the entered data, use a spreadsheet to calculate points along the curve 
using the following equation. Note that the S-N curve is a straight line only for a log-log 
plot (see Figure 12). 

𝑁 = 𝑁0 (
𝑆𝑢

𝑆𝑎
)

1

𝐵
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Log-log plot. 
The scale of the 
axes are approx-
imately equal; thus, 
the slope of the 
curve could be 
measured. In this 
example, it looks to 
be close to input of 
0.13. 

 

Semi-log plot. 

 

Linear plot 

FIGURE 12 - PLOTS OF ENTERED S-N DATA (CORRESPONDS TO INPUT IN FIGURE 11) 

 

2.2 Strain-Life Material Properties 

Recall that the E-N curve is the sum of the elastic and plastic strain. Those two lines are defined 
by the following material properties: 

 EF is the fatigue ductility coefficient. (It is usually designated as 'f in literature.) It is the 
true strain corresponding to failure in one reversal. 

 C is the fatigue ductility exponent. It is the slope of the plastic strain line (on a log-log 
plot). 

 SF is the fatigue strength coefficient. (It is usually designated as ’f in the literature.) It is 
the true stress corresponding to failure in one reversal. Therefore, the elastic strain line 
begins at a strain equal to stress/modulus of elasticity (SF/E). 
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 B is the fatigue strength exponent. It is the slope of the elastic strain line (on a log-log 
plot).  

 
The total strain, which equals the sum of the elastic and plastic strains, is the relationship 
between the fatigue life and the strain. The total strain is then given by the following equation 
(the Manson-Coffin relationship): 

𝜀

2
=

𝑆𝐹

𝐸
(2𝑁)−𝐵 + 𝐸𝐹(2𝑁)−𝐶 

 

FIGURE 13 - MATERIAL INPUT FOR STRAIN-LIFE E-N CURVE 

 

3. Load History 

Fatigue is all about loads that vary over a cycle. 
 

3.1 Multi-Axial Fatigue Loading 

Since a multi-axial fatigue analysis is a linear static stress analysis, the same types of loads 
applicable to linear stress can be applied to the fatigue analysis. 
 
Each load can be assigned to a load history to describe how it changes throughout the cycle. 
On the “Load” dialog box, click the load history “Define” or “Edit” button to define a new table or 
to edit an existing table. See Figure 14.  
 
Loads that are not assigned to a load history are constant over the cycle. 
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FIGURE 14 - DEFINE A LOAD HISTORY 

 

Time Value (X input) 

The time used for the load history is significant because the calculated life is in units of time, not 
in units of cycles. See the description for the Event Duration in the next section. 
 

Load Magnitude (Y input) 

In particular, In-CAD is looking for the peaks in the load history cycle. What happens in between 
the peaks is not relevant. Therefore, the load histories in Figure 15 represent a load that 
reverses completely, and each will give identical results. Since the last representation is the 
easiest to enter, this is the type of input that will be used most often. 
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A perfect sine wave 

 

A square wave 

 

A saw-tooth representation of a sine 
wave 

FIGURE 15 - IDENTICAL LOAD HISTORIES FOR REVERSING LOAD 

 
Note:  Each applied load creates a separate static analysis that is solved and then 

combined (per the load history) to creating the stress results used for the fatigue 
calculation. To reduce the analysis runtime, identical loads applied to different 
areas of the model should be applied using one load entry instead of multiple 
entries. 

 

Repetitive Cycles 

The load history represents the “cycle” that is repeated. In other words, the calculated life will 
indicate how many load histories will be performed until the part fails.  
 
These two load histories will result in the same calculated life (in units of time) since each 
history has the same number of cycles per time (1 cycle per 5 seconds): 
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FIGURE 16 – SAME CALCULATED LIFE 

 
These two load histories will result in different calculated lives (in units of time). Of course, the 
number of cycles until failure will be identical: 

  
Life = T seconds Life = 0.5T seconds 
Number of cycles = T/(5 sec/cycle)  
 = 0.2T 

Number of cycles = 0.5T/(2.5 sec/cycle)  
 = 0.2T 

FIGURE 17 - DIFFERENT CALCULATED LIFE 

 
If the design is subjected to multiple patterns before the cycle repeats, the load history needs to 
include the multiple patterns. For example, this load curve (Figure 18) represents a “cycle” in 
which the tension repeats 4 times, followed by the compression repeating 3 times, and then the 
cycle repeats. 

 

FIGURE 18 
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3.2 Vibration Fatigue Loading 

The loading in a vibration fatigue analysis is a power spectral density (PSD). The setup is 
identical to a random response analysis. 
 
Since the fatigue results are related to time, the Event Duration must be provided in the Fatigue 
Setup dialog (Figure 19). As explained in the results section, an estimated number of cycles per 
second is determined from the PSD, and this estimate is used to determine the life. 
 

4. Additional Fatigue Setup 

 

FIGURE 19 

 
The Fatigue Setup dialog box is used to set the following items: 

 Approach determines whether the calculations is based on the stress-life calculation 
(using the S-N data entered for the material properties) or strain-life calculation (using 
the E-N data entered for the material properties). 

 Method determines what type of stress (or strain) is used for the fatigue life calculations. 
All three methods combine the multi-axial stress state into a single, combined value. 

o Maximum principal 
o Von Mises 
o Maximum shear. Note that the maximum shear is half the stress intensity. 

 Threshold. When the amplitude change between two sequential data points is less than 
the threshold percent of the maximum range, the data point is discarded in the life 
calculation. 

 Event Duration is a way to specify that one cycle is longer than the time span indicated 
by the load histories. For example, an indexing machine may cycle once a minute, but 
the actual load cycle lasts only 5 seconds. The input for the load history would be for the 
5 seconds duration (Figure 16 for example), and the Event Duration would be the full 60 
seconds. (The Event Duration affects the life calculation as described below.) If the 
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Event Duration is blank or shorter than the time span from the load histories, the value 
defaults to the longest time span from the load histories. 

 Time Conversion Factor multiplies the Event Duration. It is typically used to convert the 
time from seconds to another unit of time. For example, to convert seconds to hours, the 
conversion factor would be 2.77E-4 (= 1 hr/3600 seconds). 

𝑇𝑖𝑚𝑒 𝑓𝑜𝑟 𝑜𝑛𝑒 𝑐𝑦𝑐𝑙𝑒 = 𝐸𝑣𝑒𝑛𝑡 𝐷𝑢𝑟𝑎𝑡𝑖𝑜𝑛 × 𝑇𝑖𝑚𝑒 𝐶𝑜𝑛𝑣𝑒𝑟𝑠𝑖𝑜𝑛 𝐹𝑎𝑐𝑡𝑜𝑟 
 

Results: Multi-Axial Fatigue 

The multi-axis fatigue analysis produces the following results: 
1. One set of static stress results due to each of the applied loads: stress, displacement, 

and so on. See Figure 20. The results are based on the entered load and are not 
adjusted by the load history. There is no result due to all of the applied loads, nor are 
there any results due to the loads applied at any time T throughout the cycle. (To see the 
results due to all of the loads applied simultaneously, perform a linear static analysis or a 
Transient Response.) 

2. The Solid Life contour is the calculated time until failure at each node. This is not the 
number of cycles. To calculate the number of cycles to failure, divide the Life by the 
Event Duration. 

3. The Solid Damage contour is 1/number of cycles to failure. 

 

FIGURE 20 – 3 LOAD SETS, 3 SETS OF RESULTS (NOT NECESSARILY IN THE SAME ORDER) 
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If the number of cycles to failure were to be calculated by hand, the following procedure would 
be used: 
 

1. If the calculated stress is compressive, the number of cycles to failure is assumed to be 
infinite.  
 

Warning about compression results: The effect of load history is not considered 

when determining if a node is in compression or tension. A load that causes compression 
stresses should have a finite life if the load history creates tension, but this does not 
happen.  

2. If the calculate stress is tensile, the maximum stress (Smax) and minimum stress (Smin) are 
determined from all of the points throughout the define cycle. 

3. The midrange stress is calculated as follows: 

𝑆𝑚 =
𝑆𝑚𝑎𝑥 + 𝑆𝑚𝑖𝑛

2
 

4. The alternating stress is calculated as follows: 

𝑆𝑎 = |
𝑆𝑚𝑎𝑥 − 𝑆𝑚𝑖𝑛

2
| 

5. When the midrange stress is positive (tension), the alternating stress is adjusted to 
account for the non-zero mean stress. The zero-mean alternating stress is 

𝑆𝑎0 =
𝑆𝑎

1 −
𝑆𝑚

𝑆𝑢

 

If the mean stress is negative (compression), then Sa0=Sa. 

6. The S-N curve is interpolated using the zero-mean alternating stress to calculate the 
number of cycles: 

𝑖𝑓 𝐾𝑓 × 𝑆𝑎0 > 𝑆𝑒 (𝑓𝑖𝑛𝑖𝑡𝑒 𝑙𝑖𝑓𝑒), 𝑁 = 𝑁0 (
𝑆𝑢

𝐾𝑓 × 𝑆𝑎0
)

1

𝐵

 

 

𝑖𝑓 𝐾𝑓𝑆𝑎0 ≤ 𝑆𝑒 (𝑖𝑛𝑓𝑖𝑛𝑖𝑡𝑒 𝑙𝑖𝑓𝑒), 𝑁 = 𝑁𝑒 (
𝑆𝑒

𝐾𝑓 × 𝑆𝑎0
)

1

𝐵𝑒

 

7. If the load history consists of one “cycle”, then the calculated life N in cycles is converted 
to time, based on the event duration for one cycle. 

𝐿𝑖𝑓𝑒 = 𝑁 × 𝐸𝑣𝑒𝑛𝑡 𝐷𝑢𝑟𝑎𝑡𝑖𝑜𝑛 

If the load history consists of multiple cycles at different stress levels, the Palmgren-
Miner’s rule and rain-flow counting is used to calculate the damage that occurs during 
one load history: 

𝐷𝑎𝑚𝑎𝑔𝑒 =  ∑
𝑛𝑖

𝑁𝑖
 

where ni is the number of cycles at a stress level of Sao and Ni is the calculated number of 
cycles to failure at a stress level of Sao. The life is then calculated as follows: 

𝐿𝑖𝑓𝑒 =  
𝐸𝑣𝑒𝑛𝑡 𝐷𝑢𝑟𝑎𝑡𝑖𝑜𝑛

𝐷𝑎𝑚𝑎𝑔𝑒
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The time correction factor, if entered by the user, is applied to the calculated life to 
convert the value to a different unit of time. 

 
 
If the value entered for Su is the ultimate tensile strength, then this procedure is equivalent to the 
modified Goodman relation: 

𝑆𝑎

𝑆𝑒
+

𝑆𝑚

𝑆𝑢𝑡
= 1 

If the value entered for Su is the yield strength, then this procedure is equivalent to the 
Soderberg line: 

𝑆𝑎

𝑆𝑒
+

𝑆𝑚

𝑆𝑦
= 1 

 

Results: Vibration Fatigue 

Since fatigue uses time-based loads (the repetitive cycle) to calculate the life, but the PSD load 
is not time based, the method of calculating the fatigue life from a random vibration analysis is 
quite involved. This document will not attempt to give the complete details but will give a high-
level summary. 
 
Although, there are many ways of calculating the fatigue life from the effective stress PSD, the 
vibration fatigue uses Steinberg method which assumes that no stress cycles occur with 
amplitudes greater than six RMS values. The distribution of stress amplitudes is assumed to 
follow a Gaussian distribution. Since the RMS value is equivalent to one-sigma variation, the 
stress amplitude cycles to occur with the following probability: 

 68.3% time at 1*RMS 

 27.1% time at 2*RMS 

 % time at 3*RMS 
 
Likewise, the number of cycles encountered in each stress amplitude band is estimated from 
the PSD as follows: 

 1*RMS stress amplitude: n1 = 0.6830NT 

 2*RMS stress amplitude: n2 = 0.2715NT 

 3*RMS stress amplitude: n3 = 0.0433NT 
where NT is the number of cycles represented in the PSD calculated from an estimation of the 
number of zero crossings with positive slope in the PSD. 
 
From the calculated stresses and the S-N curve, the number of cycles to failure can be 
calculated for each stress amplitude as follows: 

𝑓𝑜𝑟 𝑠𝑡𝑟𝑒𝑠𝑠 𝑎𝑚𝑝𝑙𝑖𝑡𝑢𝑑𝑒 𝑎𝑡 1𝑅𝑀𝑆, 𝑁1 = 𝑁0 (
𝑆𝑢

1𝑅𝑀𝑆
)

1

𝐵

 

𝑓𝑜𝑟 𝑠𝑡𝑟𝑒𝑠𝑠 𝑎𝑚𝑝𝑙𝑖𝑡𝑢𝑑𝑒 𝑎𝑡 2𝑅𝑀𝑆, 𝑁2 = 𝑁0 (
𝑆𝑢

2𝑅𝑀𝑆
)

1

𝐵

 

𝑓𝑜𝑟 𝑠𝑡𝑟𝑒𝑠𝑠 𝑎𝑚𝑝𝑙𝑖𝑡𝑢𝑑𝑒 𝑎𝑡 3𝑅𝑀𝑆, 𝑁3 = 𝑁0 (
𝑆𝑢

3𝑅𝑀𝑆
)

1

𝐵

 



 

Fatigue Analysis with Nastran In-CAD 
Report Generation 

 

Revision 1 Page 26 

 
The total damage from the three bands of stress amplitude is thus 

𝐷𝑎𝑚𝑎𝑔𝑒 =  
𝑛1

𝑁1
+

𝑛2

𝑁2
+

𝑛3

𝑁3
 

 

Report Generation 

Unfortunately, In-CAD only generates reports for a linear static analysis. This leaves you to 
generate the fatigue report manually. 
 
The type of data to enter into the report includes the following: 

 Type of analysis: 
o Multi-Axial Fatigue (repetitive loading) or Vibration Fatigue (random vibration 

loading) 

 Analysis Options: 
o Stress-life or Strain-life analysis 
o Result type used: Maximum principal, von Mises, or Maximum Shear 

 Material Properties: 
o Modulus of elasticity 
o For stress-life:  

o The ultimate tensile strength or yield strength 
o The endurance limit and modification factors applied 
o The points (N0, Su), (Ne, Se) and the calculated slope: B 
o Slope after “high cycle” fatigue: Be 
o Plot of the S-N curve (created manually) 

o For strain-life: 
o For the plastic strain line, the fatigue ductility coefficient (EF) and 

exponent (C). 
o For the elastic strain line, the Fatigue strength coefficient (SF) and 

exponent (B) 
o Plot of the E-N curve (created manually) 

 Loading 
o List of applied loads 
o Load history for each load (for multi-axial fatigue) 
o Statement such as “The load histories are multipliers for the linear static stress 

results.” 
o The duration of one repetitive cycle. 

 Results 
o The life contour, annotated to indicate the following: 

o The results are in units of time. 
o Based on the duration of one repetitive cycle, the minimum life is X 

cycles. (multi-axial fatigue) 
o Stress and displacement results, annotated to indicate to which point on the load 

history the results correspond. 
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Examples 

Example 1: Rotating Shaft 

Given: A rotating steel shaft with the following properties is simply supported in ball bearings at 
A and D: 

 Ultimate tensile strength Sut = 690 MPa 

 f = 0.844 (fatigue strength fraction, for S at end of low cycle) 

 Polished endurance limit S’e = 345 MPa 

 Surface factor ka = 0.798 

 Size factor kb = 0.858 

 Stress concentration at shoulder B, Kf = 1.55 
(Reference 1, Example 6-9, pages 291-292) 
 
Find: Estimate the life 

 
FIGURE 21 - ALL DIMENSIONS IN MILLIMETERS 

 
Solution (hand calculation): 
The transition from low cycle to high cycle is assumed to occur at 1000 cycles and Su, where 

𝑆𝑢 = 𝑓 × 𝑆𝑢𝑡 = 0.844 × 690 = 582 𝑀𝑃𝑎 

The transition from high cycle to infinite life is assumed to occur at 1E6 cycles and Se. The 
corrected endurance limit Se is calculated using the correction factors ka through kf (not to be 
confused with the stress concentration factor Kf), where kc through kf are assumed to be 1: 

𝑆𝑒 = 𝑘𝑎𝑘𝑏𝑘𝑐𝑘𝑑𝑘𝑒𝑘𝑓𝑆𝑒
′ = 0.798 × 0.858 × 345 = 236 𝑀𝑃𝑎 

From a moment diagram, shaft diameters, and stress concentrations at each fillet, it can be 
shown that the maximum stress will occur at B where the moment MB is 695.5 Nm. The section 
modulus is 

𝐼

𝑐
=

𝜋𝑑3

32
=

𝜋323

32
= 3.217 × 103 𝑚𝑚3 = 3.217 × 10−6 𝑚3 

and the stress is 

𝜎𝐵 = 𝐾𝑓

𝑀𝐵

𝐼 𝑐⁄
= 1.55

695.5 𝑁𝑚

3.217 × 10−6 𝑚3
= 335 𝑀𝑃𝑎 

Because the stress reverses completely, the maximum and minimum stress are Smax = 335 MPa 
(tension) and Smin = –335 MPa (compression) leading to the mean and alternating stress of 
Sm=0 and Sa=335 MPa. Since the mean stress is 0, the zero-mean alternating stress is 
Sa0=Sa=335 MPa. 
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The slope of the S-N curve is  

𝐵 =
log(𝑆𝑢) − log(𝑆𝑒)

log(𝑁𝑒) − log(𝑁0)
=

log(582) − log(236)

log(1𝐸6) − log(1𝐸3)
= 0.1308 

Interpolating the S-N curve at the zero-mean alternating stress gives the answer 

𝑁 = 𝑁0 (
𝑆𝑢

𝑆𝑎0
)

1

𝐵

= 1000 (
582

335
)

1

0.1308

= 68,200 𝑐𝑦𝑐𝑙𝑒𝑠 

 
Solution (In-CAD): 
1. Model the shaft. 

a. Build the model using units of millimeters. Place the axis of the shaft parallel to the X 
axis, and the cross-section of the profile in the XY plane. 

b. Rotate the profile 180 degrees. Because of symmetry, only half of the shaft is modeled. 
(The Z axis will be perpendicular to the symmetry face.) 

c. The shoulders at the bearings are kept 5 mm short of the centerlines A and B. Rigid 
elements will be used to connect the ends of the shaft to a single point on the shaft 
centerline representing the simple supports. Create work points at A and B on the shaft 
centerline. 

d. Split the outside surface of the shaft at the location of the load so that the load can be 
distributed around the perimeter of the shaft. (If it were applied at a single point at the 
top of the shaft, it would create an artificially high stress that would result in an artificially 
low life.) 

2. Enter the In-CAD environment. The units should be N, mm, and seconds. 
3. Edit the analysis (“Analysis > Edit”) and set the “Type” to “Multi-Axial Fatigue”. Click “OK” to 

set. 
4. Edit the Material (“Prepare > Material”). 

a. Select a steel from the library, such as “Autodesk Material Library > Steel – Mild”. 
b. Select “Solid 1” in the Idealization box to assign the material to the shaft. 
c. Click the “Fatigue” button. Enter the following properties in the “S-N Data” tab based on 

the hand calculations: 
i. B=0.1308 
ii. Su=582 MPa 
iii. N0=1000 cycle 
iv. Se=236 MPa 

d. Click “OK” and “OK” to save the material properties. 
5. Create the connectors for each of the bearings. 

a. Right-click on “Model > Connectors” in the browser and choose “New”. 
b. Set the “Type” to “Rigid Body”. The “Rigid Body Type” should default to “Rigid”. 
c. With the “Dependent Entities” box selected, click the face at the “A” end of the shaft. 
d. Uncheck all degrees of freedom except for “TX” and “TY”. 
e. With the “Select Point” box selected, click the work point at the “A” end of the shaft. 
f. Click “OK” to create the rigid connector. 
g. Repeat these steps to create the rigid connector at point “D”. 

6. Create constraints for the bearings (“Setup > Constraints”). 
a. Select the work points at A and D. 
b. Click the “Pinned” button to set the Tx Ty Tz translation constraints. 
c. Click “OK” to apply the constraint. 
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7. Create a constraint on the symmetry plane of the shaft (“Setup > Constraints”). 
a. Select the symmetry face. 
b. Click the “Z” symmetry button. 
c. Click “OK” to apply the constraint. 

8. Add a load (“Setup > Load”). 
a. Select the edge where the outside surface was split at the load location. 
b. Because of symmetry, enter the magnitude of 3400 N (half the total load) in the 

appropriate direction. 
c. In the “Load History Table Data” section, click the “Define New Table” button to define a 

fully reversing load to simulate the rotation of the shaft.  
d. Set the “Type” to “Load Scale Factor vs. Time”. 
e. As the shaft rotates, the stress at any point ranges from 0 to maximum to minimum to 0. 

To keep things simple so that the calculated life in seconds equals the number of cycles 
to failure, use a duration of 1 second. Enter the following in the table: 

Time (seconds) Load Scale Factor 

0 0 

0.25 1 

0.75 -1 

1 0 

f. Click “OK” and “OK” to save the load history and the load. 
9. Since the highest stress is expected to occur at one of the fillets, use the mesh control to 

specify a mesh size of 0.5 mm on each of the fillets. 
a. “Mesh > Mesh Control” 
b. Specify an “Element Size” of 0.5 mm. 
c. Select the box for “Selected Faces”. 
d. Select each of the 4 fillets on the model. The “Selected Faces” box is updates as each is 

clicked. 
e. Click “OK” 

10. Edit the mesh settings (“Mesh > Mesh Settings”) and set the mesh size to 5 mm. Set the 
“Element Order” to “Parabolic”, and then generate the mesh (“Generate Mesh”). Click “OK” 
when the mesh is finished. 

11. Run the analysis (“Solve > Run”) 
12. Check the results to make sure the model was setup properly: 

a. The displaced shape should show that it deflects as a simply-supported shaft. In other 
words, the ends of the shaft rotated as a ball bearing would allow. The maximum 
displacement is 1.4 mm. 

b. Since the fatigue setup was not changed, the fatigue calculation is using the maximum 
principal stress. The maximum principal stress is 374 MPa and is located at point B. 
(Edit the “von Mises” result and set the “Type” to “Solid Max Prin Stress”.) The principal 
stress includes shear stresses and Poisson’s effects, in addition to the bending stress, 
so it will not be equal to the hand calculation. The mesh size also has an effect on the 
accuracy of the maximum stress. 

c. The reaction force should equal 3400 N since half of the shaft was modeled. (Right-click 
on the bearing constraint in the browser and choose “SPC Summation”). 

13. The Life Contour result is a minimum of 61940 seconds. Since the event duration is 1 
sec/cycle, the calculate fatigue life is 61940 cycles. (Note that the accuracy of the calculated 
life will depend on the mesh size, too.) Note that the minimum life is only shown on the 
tension side of the shaft. Although the compression side experiences the same range of 
stresses, the calculation does not consider the compression results. 
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Revision Date Changes 

0 2016 
Oct 31 

Initial release 

1 2016 
Nov 3 

Corrected warning about material properties. Fatigue analysis does use multiple materials, 
but failing to remesh the model when necessary may prevent the analysis from using the 
changes made to the material properties. 

 

https://www.youtube.com/watch?v=rIsy4fDXDwM
https://www.youtube.com/watch?v=Fvk64Qn9K7E

